Software Requirements Specification

TheraWii

Tim Chagnon
Joe Kokinda
Andrew Meinert
Don Naegely

February 17, 2009
Revision 19
## SRS Revisions

<table>
<thead>
<tr>
<th>Date</th>
<th>Description</th>
<th>Revision</th>
<th>Editor</th>
</tr>
</thead>
<tbody>
<tr>
<td>10/27/2008</td>
<td>Created the document</td>
<td>0</td>
<td>Don Naegely</td>
</tr>
<tr>
<td>10/27/2008</td>
<td>Set up formatting information, title page, and header/footer</td>
<td>1</td>
<td>Don Naegely</td>
</tr>
<tr>
<td>10/27/2008</td>
<td>Created this table and some section headers</td>
<td>2</td>
<td>Don Naegely</td>
</tr>
<tr>
<td>11/09/2008</td>
<td>Added macros for Requirements, Use Cases</td>
<td>3</td>
<td>Tim Chagnon</td>
</tr>
<tr>
<td>11/09/2008</td>
<td>Configured doc to read func. req. sections from file</td>
<td>4</td>
<td>Don Naegely</td>
</tr>
<tr>
<td>11/10/2008</td>
<td>Made minor formatting tweaks, changed name to TheraWii</td>
<td>5</td>
<td>Don Naegely</td>
</tr>
<tr>
<td>11/10/2008</td>
<td>Included abstract and created separate sections</td>
<td>6</td>
<td>Don Naegely</td>
</tr>
<tr>
<td>11/11/2008</td>
<td>Updated the Introduction section</td>
<td>7</td>
<td>Joe Kokinda</td>
</tr>
<tr>
<td>11/12/2008</td>
<td>Added profile management functional requirements</td>
<td>8</td>
<td>Don Naegely</td>
</tr>
<tr>
<td>11/12/2008</td>
<td>Updated Menus/Workflow sections and Priority Descriptions</td>
<td>9</td>
<td>Tim Chagnon</td>
</tr>
<tr>
<td>11/16/2008</td>
<td>Added new user interface screen shots</td>
<td>10</td>
<td>Andrew Meinert</td>
</tr>
<tr>
<td>11/17/2008</td>
<td>Updated Definitions</td>
<td>11</td>
<td>Joe Kokinda</td>
</tr>
<tr>
<td>11/17/2008</td>
<td>Added 2D game descriptions</td>
<td>12</td>
<td>Don Naegely</td>
</tr>
<tr>
<td>11/18/2008</td>
<td>Updated interface screen shots</td>
<td>13</td>
<td>Andrew Meinert</td>
</tr>
<tr>
<td>11/18/2008</td>
<td>Organized screen shots</td>
<td>14</td>
<td>Tim Chagnon</td>
</tr>
<tr>
<td>11/23/2008</td>
<td>Revised Task Editor Section 4.3.4</td>
<td>15</td>
<td>Tim Chagnon</td>
</tr>
<tr>
<td>11/23/2008</td>
<td>Revised sections 4.3.3, 4.3.5-4.3.7</td>
<td>16</td>
<td>Joe Kokinda</td>
</tr>
<tr>
<td>11/23/2008</td>
<td>Revised Menu Section 4.3.2</td>
<td>17</td>
<td>Andrew Meinert</td>
</tr>
<tr>
<td>11/24/2008</td>
<td>Added the remaining content and reordered sections</td>
<td>18</td>
<td>Don Naegely</td>
</tr>
<tr>
<td>11/25/2008</td>
<td>Edited for spelling, grammar, and completeness</td>
<td>19</td>
<td>Don Naegely</td>
</tr>
</tbody>
</table>
Contents

1 Abstract 1

2 Introduction 1
  2.1 Purpose .................................................. 1
  2.2 Scope ..................................................... 1
  2.3 Definitions, Acronyms,Abbreviations .................................................. 2
    2.3.1 Physical Therapy ...................................... 2
    2.3.2 Nintendo Wii ......................................... 2
    2.3.3 Software ............................................. 2
  2.4 Developers’ Responsibilities .................................................. 2

3 General Description 2
  3.1 Functional Overview .......................................... 2
  3.2 User Characteristics .......................................... 3
  3.3 General Constraints ........................................... 3
  3.4 Assumptions and Dependencies ..................................... 3

4 Specific Requirements 3
  4.1 Requirement Priorities ......................................... 3
  4.2 Inputs ...................................................... 3
  4.3 Functional Requirements ........................................ 4
    4.3.1 General ............................................... 4
    4.3.2 Menus ............................................... 4
    4.3.3 Therapy Editor ....................................... 5
    4.3.4 Task Editor .......................................... 7
    4.3.5 Profile Manager ..................................... 9
    4.3.6 Exporting ........................................... 11
    4.3.7 Session Details ..................................... 11
    4.3.8 Therapy Execution .................................. 11
  4.4 External Interface Requirements ................................... 12
    4.4.1 Sample “About” Window .................................. 12
    4.4.2 Sample “Therapy Editor” Window ......................... 12
    4.4.3 Sample “Dialog Task Editing” Window ..................... 13
    4.4.4 Sample “2D Task Editing” Window ......................... 13
    4.4.5 Sample “Profile Management” Window ...................... 14
    4.4.6 Sample “Session Detail” Window ........................ 14
    4.4.7 Sample “2-D Task” ................................... 15
  4.5 Performance Constraints ......................................... 15
  4.6 Design Constraints ........................................... 15
    4.6.1 Software Constraints .................................. 15
    4.6.2 Hardware Constraints .................................. 15
    4.6.3 Acceptance Constraints ................................ 16

5 References 17
1 Abstract

There is an emerging trend toward using video games as a means of increasing patient engagement in physical therapy. This trend is primarily driven by the newest generation of consumer console systems which use motion-based controls. However, clinical research into the efficacy of these systems is hindered by the inability to automatically collect data from systems and software which were not intended for this purpose.

We will create a new piece of software that will give researchers the ability to experiment and quantitatively assess the value of game-based therapy. This software will provide an extensible framework for games or interactive experiments as well as an example suite of activities. The key aspect of this framework will allow researchers to easily gather data from motion-based input controls such as the Wii Remote. Various reporting methods and analysis tools will be provided for the gathered data.

2 Introduction

2.1 Purpose

Humans are capable of various types of movement, from running that involves great agility to simply standing. This great range of motion requires a system of control for the body’s balance. The balance control system is constantly working to allow our bodies to move and act in the desired way. However, when we lose our balance and fall, a number of problems may occur.

An issue that is attracting the interest of researchers and clinicians is the degeneration of the balance control system in the elderly. In the 80+ age group for every 100,000 deaths, 185.6 are due to falls. This is surprisingly higher than the highly publicized motor vehicle accident death rate of the 15 to 29 age group, for every 100,000 deaths, 21.5 are due to motor vehicle accidents. Additionally, if the elderly who fall and break a hip, 25% will die within the first six months and 50% will never walk again. [1]

These startling statistics have gained the attention of physical therapists interested in helping balance control patients recover and return to an independent life. However, conventional research methods and physical therapy techniques are costly and time consuming. These methods and techniques often require the use of force plate technology to track the posture and balance of patients throughout tests. Recording the results of the tests is also difficult to do and is often done manually. Because of the costly equipment and difficult data gathering, there is great interest in the development of a system that can record data from posture and balance related tests and store it for progress related results.

The purpose of this document is to describe the external requirements for balance- and posture-based therapy software. The requirements outlined in the document are the criteria needed for a successful software product.

2.2 Scope

This document is the describes all the requirements of the software and should be the only resource containing the system requirements. The requirements will describe functions for which the software is responsible and the environment that the software will need to encompass. It is intended for use by the developers and shall be the basis for validating the final delivered system. The developers are responsible for asking for clarifications, where necessary, and shall not make any alterations without the permission of the client.
2.3 Definitions, Acronyms, Abbreviations

2.3.1 Physical Therapy

Posture The orientation of any body segment relative to the gravitational vector. It is an angular measure from the vertical [1].

Balance The dynamics of body posture that prevents falling. It is related to the inertial forces acting on the body and the inertial characteristics of body segments [1].

Center of Mass (COM) A specific point at which the system’s mass behaves as if it were concentrated [1].

Center of Pressure (COP) The point location of the vertical ground reaction force vector. It represents a weighted average of all the pressures over the surface of the area that is in contact with the ground. It is also called the Center of Balance (COB) [1].

2.3.2 Nintendo Wii

Wii Remote Device that communicates through Bluetooth wireless protocol to the Nintendo Wii Gaming System. Data communicated includes button press and releases, accelerometer readings, and an Infrared (IR) LED pointing system.

Wii Balance Board Device that communicates the COP through Bluetooth wireless protocol to the Nintendo Wii Gaming System.

2.3.3 Software

Therapy A series of tasks that is completed in one session.

Session A given time in which a user completes a therapy.

Task A subunit of a therapy that has an objective with success and fail criteria.

2.4 Developers’ Responsibilities

Developers must do the following:

- Maintain readable, maintainable code.
- Maintain clear, relevant documentation.
- Design and implement the system to meet, at a minimum, the Priority 1 (see [4.1]) requirements in the Functional Requirements section (see [4.3]).

3 General Description

3.1 Functional Overview

The software shall be designed for two user groups and provide profiles for all users. The first user group is physical therapists who will be able to create and manage therapies through the Therapy Editor. They will have the ability to add, delete, and reorder tasks in a therapy and will be able to create and manage profiles through the Profile Manager. The second user group consists of physical therapy patients. Patients will have the ability to create a new profile through the Profile Editor. Using his or her own profile, the user will be able to participate in therapies by completing the designated tasks. The software will record the results for the each task and provide output of the data to a physical therapist. The physical therapist will be able to export the data to a file for later use. All data from a profile as well as from session(s) within a profile will be available for inspection and export.
3.2 User Characteristics

There are two user groups for this software system: physical therapists and patients. The characteristics of each are the same and are defined below:

- Familiar with standard Windows™ programs and able to run the program from the “Start Menu” or from a desktop shortcut.
- Familiar with the Wii to the point that they can turn it on and connect the devices.
- (Physical therapists) Understand the Comma Separated Values (CSV) file format so that they can interpret the export output.

3.3 General Constraints

The software will rely on the Microsoft .Net Framework and needs version 2.0 or greater to function properly. The hardware the software will run on needs the basic components of a computer along with a minimum of one USB slot, a Bluetooth USB device, and the minimum computer specifications of 100 MB of hard disk space, 256 MB of available memory, a 1GHz processor, and 64 MB video card. The software constraints are described in more detail in [4.6.1] and the hardware constraints are described in [4.6.2].

3.4 Assumptions and Dependencies

- Assumptions
  - Users meet all characteristics outlined in [3.2].
  - The system has one Bluetooth USB receiver for every Wii input device (see [4.2].
  - Users have permissions allowing them to install software, execute software, and write to files on the system.
  - The system meets all constraints outlined in [4.6.1] and [4.6.2].

- Dependencies
  - The system is running Windows 2000™ or greater.
  - Microsoft .Net 2.0 or later is installed and configured correctly.

4 Specific Requirements

4.1 Requirement Priorities

<table>
<thead>
<tr>
<th>Priority Level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Priority 1</td>
<td>Essential and required functionality</td>
</tr>
<tr>
<td>Priority 2</td>
<td>Desirable functionality</td>
</tr>
<tr>
<td>Priority 3</td>
<td>Extra features</td>
</tr>
</tbody>
</table>

4.2 Inputs

r1.1 The software shall have the ability to communicate with multiple input devices. **Priority 1**

r1.1.1 **Keyboard** The keyboard shall be plugged into the computer. **Priority 1**

r1.1.2 **Mouse** The mouse shall be plugged into the computer. **Priority 1**

r1.1.3 **Wii Remote** The Wii Remote shall communicate with the software through a Bluetooth Wireless device. **Priority 1**
r1.1.4 **Wii Balance Board** The Wii Balance Board shall communicate with the software through a Bluetooth Wireless device. *Priority 1*

4.3 Functional Requirements

4.3.1 General

r2.1 The software shall include a standard Windows™ installer for installation on a system. *Priority 1*

r2.2 The software shall have the ability to be launched from an icon on the Desktop. *Priority 1*

r2.3 The software shall have the ability to be launched from an entry in the “Start Menu.” *Priority 1*

r2.4 The software shall include a standard Windows™ uninstaller for removal from a system. *Priority 1*

4.3.2 Menus

r3.1 The software shall keep a persistent set of menus at the top of the Therapy/Profile window. *Priority 1*

r3.2 The software shall list the menu options as text horizontally across the top of the window. *Priority 1*

r3.3 File Menu

r3.3.1 The software shall display a drop down menu when the “File” menu is clicked on. *Priority 1*

r3.3.2 The software shall have an “Import Therapies...” option in the File menu. *Priority 1*

r3.3.3 The software shall have an “Export Therapies...” option in the File menu. *Priority 1*

r3.3.4 The software shall have an “Import Profiles...” option in the File menu. *Priority 1*

r3.3.5 The software shall have an “Export Profiles...” option in the File menu. *Priority 1*

r3.3.6 The software shall bring up the appropriate import or export dialog if any of the Import or Export menu options is clicked on (see [4.3.6]). *Priority 1*

r3.3.7 The software shall have a “Quit” option in the File menu. *Priority 1*

r3.3.8 The software shall exit the program if the “Quit” option is clicked by the user. *Priority 1*

r3.4 Edit Menu

r3.4.1 The software shall display a drop down menu when the “Edit” menu is clicked on. *Priority 1*

r3.4.2 The software shall have a “Cut” option in the Edit menu. *Priority 1*

r3.4.3 The software shall have a “Copy” option in the Edit menu. *Priority 1*

r3.4.4 The software shall have a “Paste” option in the Edit menu. *Priority 1*

r3.4.5 The software shall copy the selected text to the clipboard when either of the “Copy” or “Cut” options is clicked. *Priority 1*

r3.4.6 The software shall insert the contents of the clipboard when “Paste” is clicked, and if content was placed into clipboard by a cut operation, The software shall remove the cut content from original location. *Priority 1*

r3.4.7 The software shall support copy and paste of objects such as Therapies and Tasks. *Priority 2*

r3.5 Help Menu

r3.5.1 The software shall display a drop down menu when the “Help” menu is clicked on. *Priority 1*

r3.5.2 The software shall have an “About TheraWii” option in the Help menu. See Fig. 4.4.1. *Priority 1*
r3.5.3 The software shall bring up the “About Dialog” when the “About” option is clicked. **Priority 1**

r3.5.4 About Dialog

r3.5.4.1 The software shall list the software authors in alphabetical order by last name. **Priority 1**

r3.5.4.2 The software shall list license and copyright terms for the software. **Priority 1**

r3.5.4.3 The software shall display the software version number. **Priority 1**

r3.5.4.4 The software shall close the dialog when the “Close” button is clicked. **Priority 1**

### 4.3.3 Therapy Editor

Please see Figure 4.4.2 for an example of what the interface associated with the Therapy Editor UI could look like.

r4.1 Tab Contents

r4.1.1 The software shall display two panels in Therapy Editor Mode: Therapies and Tasks in Therapy. **Priority 1**

r4.1.2 The software shall display the Therapies panel on the left and the Tasks in Therapy panel on the right side of the window. **Priority 1**

r4.1.3 The software shall allow the user to resize the width of the two panels by sliding a vertical separator between the two panels. **Priority 1**

r4.2 Therapy Editing

r4.2.1 The software shall display a list of all therapies stored in the system in the Therapies panel. **Priority 1**

r4.2.2 The software shall display the name for each therapy in the list. **Priority 1**

r4.2.3 The software shall display the therapies in alphabetical order. **Priority 1**

r4.2.4 The software shall allow the user to select a therapy from the list by clicking on its name. **Priority 1**

r4.2.5 The software shall not allow the user to select more than one therapy from the list. **Priority 1**

r4.2.6 The software shall by default have the first therapy selected, displaying the tasks in the Task panel. **Priority 2**

r4.2.7 Removing Therapies

r4.2.7.1 The software shall remove the selected therapy when the user clicks the “Delete” button. **Priority 1**

r4.2.7.2 The software shall remove the selected therapy when the user presses the “Backspace” or “Delete” key. **Priority 2**

r4.2.7.3 The software shall prompt the user to confirm his or her decision before removing the therapy. **Priority 1**

r4.2.7.4 The software shall remove the therapy from the system records and from the list of therapies when it is deleted. **Priority 1**

r4.2.8 Adding Therapies

r4.2.8.1 The software shall allow the user to add a new therapy to the system by clicking on the “Add” button. **Priority 1**

r4.2.8.2 The software shall create a new therapy with the name “New Therapy” when the “New” button is clicked. **Priority 1**

r4.2.8.3 The software shall add the therapy to the system records and add an entry in the list of therapy. **Priority 1**
r4.3 Tasks in Therapy

r4.3.1 The software shall display a list of all tasks in a selected therapy in the Tasks in Therapy panel. *Priority 1*

r4.3.2 The software shall display the task type and task name for each task in the list. *Priority 1*

r4.3.3 The software shall change the list of tasks when the user selects a new therapy from the list of therapies in the Therapies panel. *Priority 1*

r4.3.4 The software shall allow the user to select a task by clicking on that task. *Priority 1*

r4.3.5 The software shall allow the user to deselect a task by clicking on a selected task. *Priority 1*

r4.3.6 The software shall allow the user to select more than one task. *Priority 1*

r4.3.7 Removing Tasks

r4.3.7.1 The software shall undergo no changes and issue no prompts to the user if the “Delete Task” button is clicked while no tasks are selected. *Priority 1*

r4.3.7.2 The software shall prompt the user to confirm his or her decision when they click on the “Remove” button. *Priority 1*

r4.3.7.3 The software shall include the number of tasks that will be deleted in the confirm removal dialog. *Priority 1*

r4.3.7.4 The software shall remove all selected tasks from the list and from the system records when the user confirms removal. *Priority 1*

r4.3.8 Adding Tasks

r4.3.8.1 The software shall allow the user to add a new task to the system by clicking on the “New Task” button. *Priority 1*

r4.3.8.2 The software shall bring up a new window for selecting the type of new task when the “New Task” button is clicked. *Priority 1*

r4.3.8.3 The window shall provide a combo box with the choice of “2D Task”, “3D Task”, or “Repeating Task”. *Priority 1*

r4.3.8.4 The window shall have an “Ok” Button and a “Cancel” Button. *Priority 1*

r4.3.8.5 The software shall bring up the task editing dialog (see [4.3.4]) for the type of task selected when the “Ok” button is pressed. *Priority 1*

r4.3.8.6 The software shall add the task to systems records and add an entry in the list of tasks when the user clicks the “OK” button. *Priority 1*

r4.3.8.7 The software shall undergo no changes when the user clicks the “Cancel” button. *Priority 1*

r4.3.9 Editing Tasks

r4.3.9.1 The software shall allow the user to edit an existing task by clicking the “Edit Task” button. *Priority 1*

r4.3.9.2 The software shall bring up the task editing dialog (see [4.3.4]) for the type of task selected when the “OK” button is pressed. *Priority 1*

r4.3.10 Reordering Tasks

r4.3.10.1 The software shall move the selected tasks up in the Tasks in Therapies list when the user clicks the “Move Up” button. *Priority 1*

r4.3.10.2 The software shall move the selected tasks down in the Tasks in Therapy list when the user clicks the “Move Down” button. *Priority 1*

r4.3.11 Deleting Tasks

r4.3.11.1 The software shall allow the user to remove a task from the system by clicking “Delete” button. *Priority 1*
r4.3.11.2 The software shall bring up a new window with the prompt “Are you sure you want to delete the task?” *Priority 1*

r4.3.11.3 The new window shall have a “Yes” and “No” button. *Priority 1*

r4.3.11.4 The software shall delete the task if the user selects the “Yes” button. *Priority 1*

r4.3.11.5 The software shall undergo no changes when the user clicks the “No” button. *Priority 1*

### 4.3.4 Task Editor

#### r5.1 Task Types

r5.1.1 The software shall provide a Dialog type task. See Fig. 4.4.3. *Priority 1*

r5.1.1.1 The user shall provide a name for the task. *Priority 1*

r5.1.1.2 The user shall provide the text that will be displayed. *Priority 1*

r5.1.1.3 The user shall provide an ending condition for the task. *Priority 1*

r5.1.1.4 The user shall provide an optional time limit for the task. *Priority 1*

r5.1.1.5 The software shall provide two ending conditions: “Button Press” and “None”. *Priority 1*

r5.1.1.6 If “Button Press” is selected as the ending condition, the user shall be given the option of selecting a button via a drop-down menu. *Priority 1*

r5.1.1.7 If “None” is selected as the ending condition, the user shall be required to enter a time limit. *Priority 1*

r5.1.2 The software shall provide a 2-D type task. See Fig. 4.4.4. *Priority 1*

r5.1.2.1 The user shall provide a name for the task. *Priority 1*

r5.1.2.2 The user shall select compatible 2-D input devices from a drop-down menu including “Wii Balance Board,” “Wii Remote Roll & Pitch,” “Wii Remote IR,” “Nunchuck Roll & Pitch,” “Nunchuck Joystick.” *Priority 1*

r5.1.2.3 The user shall select “Absolute” or “Differential” input handling. This will be used to interpret input effect on the patient’s cursor during the game. *Priority 2*

r5.1.2.4 The software shall provide a list of additional inputs to record with options to add and remove from the list. *Priority 1*

r5.1.2.5 The user shall select a Performance Metric to be derived from a drop-down menu. *Priority 1*

r5.1.2.6 Performance Metrics shall include “Time in Region,” “Time out of Region,” “Total Time,” “Motion Smoothness,” and “Average Speed.” *Priority 1*

r5.1.2.7 The user shall have the option of specifying a Region for use in the task. This region can be used to define an ending condition for the task and to generate a performance metric. *Priority 1*

r5.1.2.7.1 The user shall select the Shape of the region from “Ellipse” or “Rectangle.” *Priority 1*

r5.1.2.7.2 The user shall select from “Static,” “Dynamic,” or “Random” for each of the following region parameters: “Position X,” “Position Y,” “Size X,” “Size Y.” *Priority 1*

r5.1.2.7.3 If “Static” is selected for a region parameter, the user shall provide a single scalar size value. This value will be set for the parameter for any execution of this task. *Priority 1*

r5.1.2.7.4 If “Dynamic” is selected for a region parameter, the user shall provide two scalar values, Start and End. These values will be used to interpolate a setting for the parameter using the iteration number during a task which is nested in a Repeat Task. *Priority 1*

r5.1.2.7.5 If “Random” is selected for a region parameter, the user shall provide two scalar values, Minimum and Maximum. These values will be used to define the parameter from a random value in a given range. *Priority 1*

r5.1.2.7.6 The software shall provide a preview image of the region in the task environment. *Priority 1*
r5.1.2.8 The user shall provide an ending condition for the task. *Priority 1*
r5.1.2.9 The user shall provide an optional time limit for the task. *Priority 1*
r5.1.2.10 The ending condition shall be selected from the options “Button Press,” “Time in region,” and “None.” *Priority 1*
r5.1.2.11 If “Button Press” is selected as the ending condition, the user shall be given the option of selecting a button via a drop-down menu. *Priority 1*
r5.1.2.12 If “Time in Region” is selected as the ending condition, the user shall provide a time in seconds. *Priority 1*
r5.1.2.13 If “None” is selected as the ending condition, the user shall be required to enter a time limit. *Priority 1*

r5.1.3 The software shall provide a 3-D type task. *Priority 3*
r5.1.3.1 The user shall provide a name for the task. *Priority 3*
r5.1.3.2 The user shall select compatible 3-D input devices from a drop-down menu including “Wii Remote” and “Nunchuck.” *Priority 3*
r5.1.3.3 The software shall provide a list of additional inputs to record with options to add and remove from the list. *Priority 3*
r5.1.3.4 The user shall select a Performance Metric to be derived from a drop-down menu. *Priority 3*
r5.1.3.5 Performance Metrics shall include “Time in Region,” “Time out of Region,” “Total Time,” “Motion Smoothness,” and “Average Speed.” *Priority 3*
r5.1.3.6 The user shall have the option of specifying a Velocity Region for use in the task. *Priority 3*
r5.1.3.6.1 The user shall select the Shape of the region from “Ellipsoid” or “Box.” *Priority 3*
r5.1.3.6.2 The user shall select from “Static,” “Dynamic,” or “Random” for each of the following region parameters: “Position X,” “Position Y,” “Position Z,” “Size X,” “Size Y,” “Size Z.” *Priority 3*
r5.1.3.6.3 If “Static” is selected for a region parameter, the user shall provide a single scalar size value. This value will be set for the parameter for any execution of this task. *Priority 3*
r5.1.3.6.4 If “Dynamic” is selected for a region parameter, the user shall provide two scalar values, Start and End. These values will be used to interpolate a setting for the parameter using the iteration number during a task which is nested in a Repeat Task. *Priority 3*
r5.1.3.6.5 If “Random” is selected for a region parameter, the user shall provide two scalar values, Minimum and Maximum. These values will be used to define the parameter from a random value in a given range. *Priority 3*
r5.1.3.6.6 The software shall provide a preview image of the region in the task environment. *Priority 3*

r5.1.3.7 The user shall provide an ending condition for the task. *Priority 3*
r5.1.3.8 The user shall provide an optional time limit for the task. *Priority 3*
r5.1.3.9 The ending condition shall be selected from the options “Button Press,” “Time in region,” and “None.” *Priority 3*
r5.1.3.10 If “Button Press” is selected as the ending condition, the user shall be given the option of selecting a button via a drop-down menu. *Priority 3*
r5.1.3.11 If “Time in Region” is selected as the ending condition, the user shall provide a time in seconds. *Priority 3*
r5.1.3.12 If “None” is selected as the ending condition, the user shall be required to enter a time limit. *Priority 3*

r5.1.4 The software shall provide a Repeat type task. *Priority 1*
r5.1.4.1 The user shall provide a name for the task. *Priority 1*
r5.1.4.2 The user shall provide an optional number of repetitions. *Priority 1*
r5.1.4.3 The user shall provide an optional time limit for the task. *Priority 1*
4.3.5 Profile Manager

Please see Figure 4.4.5 for an example of what the interface associated with the Profile Management UI could look like.

r6.1 Tab Contents

r6.1.1 The software shall display two panels in Profile Management Mode: Profiles and Sessions in Profile. *Priority 1*

r6.1.2 The software shall display the Profiles panel on the left and the Sessions in Profile panel on the right side of the window. *Priority 1*

r6.1.3 The software shall allow the user to resize the width of the two panels by sliding a vertical separator between the two panels. *Priority 1*

r6.2 Profile Management

r6.2.1 The software shall display a list of all profiles stored in the system in the Profiles panel. *Priority 1*

r6.2.2 The software shall display the user name and the date of creation for each profile in the list. *Priority 1*

r6.2.3 The software shall display the number of sessions for each profile in the list. *Priority 3*

r6.2.4 The software shall allow the user to select a profile from the list by clicking on that profile. *Priority 1*

r6.2.5 The software shall allow the user to deselect a selected profile by clicking on that profile. *Priority 1*

r6.2.6 The software shall not allow the user to select more than one profile from the list. *Priority 1*

r6.2.7 Removing Profiles

r6.2.7.1 The software shall prompt the user to confirm his or her decision before removing the profile. *Priority 1*

r6.2.7.2 The software shall remove the selected profile when the user clicks the “Remove” button. *Priority 1*

r6.2.7.3 The software shall remove the selected profile when the user presses the “Backspace” or the “Delete” key. *Priority 2*

r6.2.7.4 The software shall remove the profile from the system records and from the list of profiles when it is deleted. *Priority 1*

r6.2.8 Adding Profiles

r6.2.8.1 The software shall allow the user to add a new profile to the system by clicking on the “New” button. *Priority 1*

r6.2.8.2 The software shall bring up a new window for setting the name for the new profile when the “New” button is clicked. *Priority 1*

r6.2.8.3 The software shall add the profile to system records and add an entry in the list of profiles when the user clicks the “OK” button. *Priority 1*

r6.2.8.4 The software shall undergo no changes when the user clicks the “Cancel” button. *Priority 1*

r6.2.9 Editing Profiles

r6.2.9.1 The software shall allow the user to edit the selected profile by clicking the “Edit” button. *Priority 1*

r6.2.9.2 The software shall bring up a new window for editing the name of the selected profile when clicking the “Edit” button. *Priority 1*
r6.2.9.3 The software shall update the system records and update the information displayed in the list to match the edited profile data when the user clicks the “Save Changes” button. *Priority 1*

r6.2.9.4 The software shall undergo no changes when the user clicks the “Cancel” button. *Priority 1*

r6.2.10 Sorting Profiles

r6.2.10.1 The software shall sort the list of profiles alphabetically from A-Z when the user clicks the “User Name” header and the list is not sorted alphabetically or is sorted Z-A. *Priority 2*

r6.2.10.2 The software shall sort the list of profiles alphabetically from Z-A when the user clicks the “User Name” header and the list is sorted from A-Z. *Priority 2*

r6.2.10.3 The software shall sort the list of profiles from most recent to oldest creation date when the user clicks the “Creation Date” header and the list is not sorted by date or is sorted oldest to most recent. *Priority 2*

r6.2.10.4 The software shall sort the list of profiles from oldest to most recent creation date when the user clicks the “Creation Date” header and the list is currently sorted from most recent to oldest. *Priority 2*

r6.2.10.5 The software shall sort the list according to the current sorting settings when a new profile is added. *Priority 3*

r6.2.10.6 The software shall sort the list according to the current sorting settings when a profile is edited. *Priority 3*

r6.3 Session Management

r6.3.1 The software shall display a list of all sessions recorded for the selected profile in the Sessions in Profile panel. *Priority 1*

r6.3.2 The software shall display the session ID, the therapy name, and the date and time for each session in the list. *Priority 1*

r6.3.3 The software shall change the list of sessions when the user selects a new profile from the list of profiles in the Profiles panel. *Priority 1*

r6.3.4 The software shall allow the user to select a session by clicking on that session. *Priority 1*

r6.3.5 The software shall allow the user to deselect a session by clicking on a selected session. *Priority 1*

r6.3.6 The software shall allow the user to select more than one session. *Priority 1*

r6.3.7 Removing Sessions

r6.3.7.1 The software shall undergo no changes and issue no prompts to the user if the “Remove” button is clicked while no sessions are selected. *Priority 1*

r6.3.7.2 The software shall prompt the user to confirm his or her decision when “Remove” button is clicked. *Priority 1*

r6.3.7.3 The software shall include the number of sessions to be deleted in the confirm removal dialog. *Priority 1*

r6.3.7.4 The software shall remove all selected sessions from the list and from the system records when the user confirms removal. *Priority 1*

r6.3.8 Session Details

r6.3.8.1 The software shall undergo no changes to the system or UI when the user clicks the “View Details” button while no sessions are selected. *Priority 1*

r6.3.8.2 The software shall open a new window for viewing more detailed information on selected sessions when the user clicks the “View Details” button (see [4.3.7]). *Priority 1*

r6.3.9 Exporting

r6.3.9.1 The software shall undergo no changes to the system or UI when the user clicks the “Export” button while no sessions are selected. *Priority 1*

r6.3.9.2 The software shall open a new window to handle different export options when the user clicks the “Export” button (see [4.3.6]). *Priority 1*
4.3.6 Exporting

r7.1 Export Types
   r7.1.1 The software shall have the ability to export in CVS format. *Priority 1*
   r7.1.2 The software shall have the ability to export in a MATLAB format. *Priority 3*
   r7.1.3 The software shall have the ability to export in an Excel format. *Priority 3*

r7.2 Profile Exporter
   r7.2.1 The software shall have the ability to export multiple profiles. *Priority 1*
   r7.2.2 The software shall have the ability to export a single profile. *Priority 1*

r7.3 Session Exporter
   r7.3.1 The software shall have the ability to export multiple sessions for a profile. *Priority 1*
   r7.3.2 The software shall have the ability to export a single session. *Priority 1*

r7.4 Therapy Exporter
   r7.4.1 The software shall have the ability to export multiple therapies. *Priority 1*
   r7.4.2 The software shall have the ability to export a single therapy. *Priority 1*

4.3.7 Session Details

r8.1 Sessions Displayed
   r8.1.1 The software shall display session information for the last session selected. *Priority 1*
   r8.1.2 The software shall display session information for all the sessions selected, one at a time, with a button to go to the next session. *Priority 3*

r8.2 Information Displayed
   r8.2.1 The software shall display the name of the therapy that was completed. *Priority 1*
   r8.2.2 The software shall display the date and time the therapy was completed. *Priority 1*
   r8.2.3 The software shall display the name of the profile that completed the therapy. *Priority 1*
   r8.2.4 The software shall display the names of the tasks in the therapy. *Priority 1*
   r8.2.5 The software shall display the types of the tasks in the therapy. *Priority 1*
   r8.2.6 The software shall display the goals of the tasks. *Priority 1*
   r8.2.7 The software shall display the data of each task in the therapy. *Priority 1*

4.3.8 Therapy Execution

r9.1 Device Synchronization
   r9.1.1 The software shall prompt user to press the sync button for all devices all tasks in the therapy.
   r9.1.2 If all devices are discovered, The software shall execute the therapy.
   r9.1.3 If device type(s) are not found, The software shall prompt user to press the sync button on the specific device(s) or allow user to cancel workflow execution.

r9.2 The software shall execute tasks in a full screen environment. *Priority 1*

r9.3 The software shall switch between tasks without exiting full screen. *Priority 1*

r9.4 The software shall allow users to pause at any point in a task. *Priority 1*

r9.5 The software shall allow users switch in an out of the full screen environment while progress is paused. *Priority 1*
4.4 External Interface Requirements

Below are some mockups of the TheraWii UI. These graphics should not be construed as the final design but as a simple graphical representation of the system.

4.4.1 Sample “About” Window

![About Window](image)

4.4.2 Sample “Therapy Editor” Window

![Therapy Editor Window](image)
4.4.3 Sample “Dialog Task Editing” Window

![Dialog Task Editing Window]

4.4.4 Sample “2D Task Editing” Window

![2D Task Editing Window]
4.4.5 Sample “Profile Management” Window

![Profile Management Window]

4.4.6 Sample “Session Detail” Window

![Session Detail Window]
4.4.7 Sample “2-D Task”

4.5 Performance Constraints
The software must respond be capable of sampling data from Wii input devices at a minimum of 10Hz.

4.6 Design Constraints

4.6.1 Software Constraints
- The software will rely on the Microsoft .Net Framework (see http://www.microsoft.com/net/overview.aspx). It is assumed that any system running this software will have the Microsoft .Net 2.0 or greater correctly installed.
- All drivers must be installed and configured for the Bluetooth USB receiver(s).

4.6.2 Hardware Constraints
- Minimum of one available USB slot
- One Bluetooth USB per Wii input device
- Keyboard and mouse
- Monitor or other video display device
- 100MB hard disk space
- 256MB available memory
- 1GHz processor
• 64MB video card

4.6.3 Acceptance Constraints

Before accepting the system, the developers must complete the following:

• Demo the working system and any features upon request.
• Prove that all Priority 1 functional requirements are met.
• Provide sufficient test cases to show that the system is complete and correct.
5 References